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Giới thiệu 

A-Tools là một công cụ (add-in) chạy trong môi trường Microsoft Excel. A-Tools có 
các chức năng chính sau:  

Chia sẻ tập tin Excel qua mạng LAN, Internet cho nhiều người dùng chung: 
Để chia sẻ tệp dữ liệu Excel cho nhiều người dùng trong mạng, nếu không có công cụ thì chỉ 
có một phương pháp là share full thư mục chứa file Excel đó (cách của Excel). Theo cách 
này, các máy trong mạng đều có thể truy cập vào copy và thậm chí xoá hẳn tệp dữ liệu này. 
Người chủ của tệp Excel này chỉ có thể gửi trọn cả tệp mà rất khó che dấu những sheets 
hay vùng dữ liệu riêng của mình. Còn các vấn đề khác như cho người dùng truy cập vào 
vùng dữ liệu nhưng có các quyền: chỉ đọc, soạn thảo, giới hạn bao nhiêu người được kết 
nối,....không thể làm được. 

Với Add-in A-Tools cho phép soạn thảo và quản trị dữ liệu Excel qua mạng. Công cụ 
này cho phép người dùng quản trị dữ liệu Excel qua mạng một cách mạnh mẽ, có thể kết 
nối các bảng tính, vùng dữ liệu qua TCP/IP (không phải share full thư mục), quản trị các kết 
nối tới vùng dữ liệu, phân quyền cho từng nhóm người dùng, khi dữ liệu tại một máy thay 
đổi thì các máy khác trong mạng được cập nhật ngay lập tức (sau khoảng ~ 1 mili giây). 

Trích lọc dữ liệu và làm báo cáo động trong Microsoft Excel: Tạo bảng dữ liệu 
động bởi việc sử dụng các hàm với ngôn ngữ truy vấn cơ sở dữ liệu (CSDL) T-SQL. Cho 
phép kết nối với các CSDL bên trong và bên ngoài như Excel, Access, Foxpro, MS SQL, 
MySQL, Firebird,… vào bảng tính Excel. Với công cụ SQL Builder sẽ giúp người dùng tạo 
công thức truy vấn dữ liệu một cách dễ dàng và hiệu quả. Người dùng có thể tạo ra những 
báo cáo trong bảng tính Excel có độ phức tạp cao, được lọc theo nhiều điều kiện, liên kết 
với các nguồn dữ liệu khác nhau, đảm bảo độ chính xác, ổn định và tốc độ xử lý nhanh. 

Hướng dẫn chi tiết: C:\A-Tools\Documents\A-Tools_Query_Report_Help.pdf 

Lập trình cùng Add-in A-Tools: Ngoài giao diện người dùng, Add-in A-Tools còn 
hỗ trợ các hàm API và các đối tượng COM như BSNetwork, BSFormulaArray để những 
người phát triển ứng dụng lập trình kết hợp cùng Add-in A-Tools nhằm khai thác tối đa năng 
lực của Add-in A-Tools, tăng sức mạnh cho ứng dụng của mình. 

Nếu bạn muốn lập trình VBA cùng A-Tools hãy đọc tài liệu tại file “A-Tools 
Programming.pdf” 

Các chức năng phụ: 

 Tạo công thức thống kê kết hợp với nhiều điều kiện, công thức mảng. 
 Chuyển đổi mã văn bản từ TCVN3, VNI sang UNICODE và ngược lại.  
 Đọc số thành chữ tiếng Việt, tiếng Anh 
 … 

  

file:///C:/A-Tools/Documents/A-Tools_Query_Report_Help.pdf
file:///C:/A-Tools/Documents/A-Tools_Programming.pdf
file:///C:/A-Tools/Documents/A-Tools_Programming.pdf
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Download,  Cài đặt và chạy Add-in A-Tools 

Người dùng cần download/tải A-Tools theo địa chỉ dưới đây: 

 A-Tools Pro – Phiên bản thương mại: 

http://www.bluesofts.net/Products/AddIns/A-Tools/A-Tools_Pro.exe 

 A-Tools Free – Phiên bản miễn phí: 

http://www.bluesofts.net/Products/AddIns/A-Tools/A-Tools_Free.exe 

 

Sau khi tải bộ cài đặt A-Tools về máy, Người dùng nhấp đúp chuột vào tệp tin và cài 
đặt bình thường. 

Lưu ý: người dùng phải đăng nhập Windows với quyền quản trị (Administrator). Khi 
cài đặt thành công, tất cả các loại user đều chạy được A-Tools. 

Để chạy A-Tools, người dùng mở Microsoft Excel, khi chương trình mở xong, người 
dùng sẽ nhìn thấy menu A-Tools nằm gần cuối các menu ngang của Microsoft Excel. 

Màn hình chức năng Add-in A-Tools 

Mở Microsoft Excel 2007. Chọn menu A-Tools người dùng sẽ thấy các chức năng của 
A-Tools như hình dưới đây. 

 

Giao diện trên Microsoft Excel 2003 hoặc các phiên bản thấp hơn 

 

http://www.bluesofts.net/Products/AddIns/A-Tools/A-Tools_Pro.exe
http://www.bluesofts.net/Products/AddIns/A-Tools/A-Tools_Free.exe
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A-Tools chạy trên các phiên bản Excel 2000/XP/2003/2007/2010 hoặc cao hơn. 

 

Chức năng máy chủ (Excel Server) 

Khởi tạo máy chủ 

Từ menu A-Tools, bấm chọn chức năng “Tạo máy chủ”  

 

 

+ Tên máy chủ: những máy khách (clients) kết nối tới máy tính này phải sử dụng tên 
hoặc địa chỉ IP để kết nối. 

+ Tên người dùng: tên hệ thống cung cấp ban đầu là “admin”. Sau khi truy cập vào 
bằng tên này, người dùng có thể tạo lại danh sách các tên được truy cập. 

+ Mật khẩu: với tên “admin” thì mật khẩu để trống. 

Chỉ những người có tên truy cập (tài khoản) và mật khẩu thì mới chạy được chức năng 
máy chủ và máy khách (Excel Network: Excel Server; Excel Client). 

Đưa các tập tin Excel vào danh sách chia sẻ 

Từ menu A-Tools, chạy chức năng “Quản trị máy chủ”. Khi màn hình hiện ra, từ cửa 
sổ bên trái hãy chọn mục “Cơ sở dữ liệu”, màn hình bên phải sẽ xuất hiện chức năng quản 
trị cơ sở dữ liệu. 
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Việc máy chủ chia sẻ dữ liệu trong mạng bắt đầu từ việc tạo danh sách các tệp dữ liệu 
Excel. 

+ Thêm: thêm tệp CSDL Excel vào danh sách quản trị của máy chủ 

+ Gỡ bỏ: gỡ bỏ tệp CSDL khỏi danh sách quản trị của máy chủ 

+ C&A: nếu được chọn các vùng dữ liệu trong CSDL này sẽ được quản lý theo quy tắc 
quản trị báo cáo – “Checking and Approval”/ Chấp nhận và Phê chuẩn. 

+ Xem: nếu được chọn, CSDL (workbook) này sẽ được nhìn thấy trong máy chủ, 
trường hợp khác nó bị ẩn. 

+ K. hoạt động: viết tăt của từ “Không hoạt động”. Nếu tệp CSDL được chọn thì các 

máy tính trong mạng không thể kết nối vào CSDL này được, trừ khi được cấp quyền từ 
máy chủ. Các vùng dữ liệu trong màn hình phân quyền sẽ bị ẩn nếu CSDL của nó bị chọn 
“K. hoạt động”. 

+ Sắp xếp: Việc sắp xếp có ý nghĩa khi mở máy chủ. Tập tin nào có số nhỏ sẽ được 
mở trước. Để thay đổi thứ tự, hãy chọn một tập tin sau đó nhấn nút Up, Down để thay đổi 
thứ tự. Việc mở tập tin trước hay sau có ý ngĩa với các tập tin có liên kết lẫn nhau. Ví dụ 
“fileB.xls” có công thức kết nối tới “fileA.xls” thì “fileA.xls” phải xếp lên trước. Lên trước để 
dữ liệu được cập nhật trước khi các tập tin khác dùng nó. 

+ Ngắt kết nối: Nếu tập tin này đang có các user mở ở các máy khách nó sẽ có màu 
xanh, chọn và bấm “Ngắt kết nối” thì tập tin này ở tất cả các máy khách đang mở sẽ đóng 
lại. Việc này cần thiết khi bạn muốn ngừng chia sẻ để sửa chữa hay nâng nó trên máy chủ. 
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+ Sao lưu: Thực hiện sao lưu các tập tin Excel ra một thư mục khác. Các tập tin sao 
lưu này vẫn được A-Tools quản lý nhưng đưa vào chế độ “Inactive”-Không hoạt động. Chi 
tiết xem tại đây. 

Lưu ý: Tập tin Excel chia sẻ trong máy chủ phải không có mật khẩu Workbook. Máy khách 
kết nối tới máy chủ, mở các sheet từ máy chủ, dữ liệu Excel sẽ không sao chép được nếu 
không phân quyền. 

 + Nút “Tạm dừng”: nếu chọn (khi đó nút bấm này đổi tên là “Tiếp tục”) máy chủ sẽ 
tạm thời khóa không cho các máy khách kết nối đến (các máy đã kết nối vẫn làm việc ), 
không cho mở các vùng dữ liệu, không cho cập nhật dữ liệu lên ngay, dữ liệu sẽ lưu tạm ở 
máy khách chỉ sau khi chọn “Tiếp tục” thì dữ liệu được cập nhật toàn bộ lên máy chủ. 

Các vùng dữ liệu cần định dạng trước khi chia sẻ trong mạng 

Add-in A-Tools tự động cập nhật định dạng giá trị: số học, tiền, tỷ lệ %, ngày, Custom 
Format. Tuy nhiên, định dạng kiểu giá trị trong Excel là rất phong phú. Để đảm bảo sự 
thống nhất cao về định dạng giá trị giữa máy chủ và máy khách, người dùng nên 
định dạng giá trị trong các vùng dữ liệu theo mỗi đặc trưng riêng của kiểu giá trị. 

 

Dữ liệu của máy chủ sau khi được định dạng cấu trúc bảng tính, kiểu giá trị, màu 
nền, màu chữ, font chữ, kẻ viền,… thì mới cho các máy khách kết nối vào. 
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Nhiệm vụ chính của máy khách là kết nối, xem và nhập giá trị. Việc định dạng sẽ 
không tự động gửi lên máy chủ, chỉ có kiểu giá trị thì tự động được định dạng tuy nhiên 
người dùng hãy nên tự định dạng kiểu giá trị trước trên máy chủ. 

 Nếu đặt bảo vệ bảng tính (Protect Sheet) với vùng dữ liệu được định dạng 
Protection->Hidden máy khách không soạn thảo được công thức. 

 

Nếu bạn định dạng vùng dữ liệu là Protection->Hidden như hình trên sau đó đặt 
Protect Sheet thì máy khách sẽ không thể soạn thảo được công thức dù không chọn 
“Locked”. 

Nếu định dạng từ máy khách, muốn cập nhật lên máy chủ thì phải làm như 
sau: 

+ Chọn vùng dữ liệu cần gửi định dạng lên máy chủ 

+ Nếu Excel 2003: vào menu A-Tools, chọn “Kết nối mạng”->”Cập nhật định dạng” 

+ Nếu Excel 2007: vào menu A-Tools, chọn “Cập nhật dữ liệu”->”Cập nhật định dạng” 

Tham khảo phần Các chức năng hỗ trợ soạn thảo và cập nhật dữ liệu lên máy 
chủ 

Tạo các vùng dữ liệu được chia sẻ trong mạng 

Trong màn hình “Quản trị máy chủ”, từ cửa sổ bên trái hãy chọn một sheet, màn hình 
bên phải sẽ xuất hiện chức năng “Vùng cho phép kết nối” để bạn thêm các vùng. 
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Các máy khách (clients) được cấp quyền sẽ mở những vùng dữ liệu này để soạn thảo. 

+ Thêm: thêm mới vùng chia sẻ. Vùng chia sẻ trong A-Tools có ba loại:  

- Toàn bộ Workbook, khi đó người dùng mở tại máy khách chỉ đọc mà không 
soạn thảo được 

- Bảng tính/Sheet, người dùng có thể đọc và soạn thảo dữ liệu toàn bảng 
tính 

- Vùng dữ liệu/Range là một tập hợp các ô liên tiếp hoặc các khối vùng rời 
rạc, người dùng mở tại máy khách chỉ có thể soạn thảo được trong vùng 
cấp phát mà thôi. 

 

+ Gỡ bỏ: gỡ bỏ vùng dữ liệu khỏi danh sách chia sẻ. 

+ Tên vùng: vùng dữ liệu được đặt tên bởi người dùng. 

+ Địa chỉ: địa chỉ vùng trong bảng tính, trong phạm vi này người dùng có thể soạn 
thảo. 

+ Tên Sheet: Tên của sheet trong workbook. 

+ Ẩn cột: Chỉ ra các cột được ẩn khi chia sẻ. 

  Ví dụ: C:D,F,I:M - ẩn các cột từ C->D, cột F, cột từ I->M 

  Ví dụ: 3:4,5,I:M - ẩn các cột từ C->D, cột F, cột từ I->M 

Có thể dùng chỉ số cột hoặc tên cột là các chữ cái. 

+ Ẩn dòng: Chỉ ra các dòng được ẩn khi chia sẻ. 

  Ví dụ: 16,17,18:22 - ẩn các dòng 16, 17, 18->22 
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+ Xác nhận: nếu được chọn, vùng dữ liệu sẽ không sửa được, không in được. Nếu 
không chọn vùng dữ liệu được sửa. Nguyên tắc này được thược hiện nếu CSDL của nó được 
chọn “C&A” – “Checking and Approval” /Chấp nhận và Phê chuẩn. Trường thông tin này cho 
phép người dùng từ các máy khách xác lập nếu được cấp quyền. 

+ Phê chuẩn: nếu được chọn và “Xác nhận” cũng được chọn thì vùng dữ liệu sẽ không 
sửa được và được phép in. Nếu không chọn vùng dữ liệu không được in. Nguyên tắc này 
được thược hiện nếu CSDL của nó được chọn “C&A” – “Checking and Approval” /Chấp nhận 
và Phê chuẩn. Trường thông tin này cho phép người dùng từ các máy khách xác lập nếu 
được cấp quyền. 

+ Tham chiếu: nếu được chọn, các công thức trong vùng này được liên kết tới các 
vùng dữ liệu ở các sheet khác trong workbook của nó. 

+ Slg đã kết nối: A-Tools đếm số người đang kết nối vào vùng dữ liệu. 

+ Slg kết nối: chỉ ra số người được kết nối tối đa vào vùng dữ liệu này. Giá trị -1 là 
không giới hạn số người kết nối. 

+ K. hoạt động: nếu được chọn, vùng này bị khóa và không cho phép người dùng kết 
nối tới nó. 

 Nếu một bảng tính được chia sẻ cho 2 người dùng ở (ở hai nhóm khác nhau). 
Người A được xem toàn bộ, người B không nhìn thấy cột G:IV. Các làm như sau: 
+ Từ cây dữ liệu ở cửa sổ bên trái, chọn tới sheet cần chia sẻ 
+ Nhìn sang cửa sổ bên phải, bạn nhấn vào mũi tên bên cạnh nút “Thêm”->”Nhận 
vùng”. Bạn tạo thêm các vùng dữ liệu mới trên sheet đã chọn. 

 

 
 
Sau khi tạo thêm vùng mới, thiết lập thuộc tính cho các vùng này. Đặt tên vùng mới như là 
“Shop1_A9_F30”, G:IV vào cột “Ẩn cột”. 
 + Tiếp theo vào mục phân quyền, phân quyền cho mỗi nhóm người A, người B được 
mở những vùng chỉ định. 
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Xây dựng danh sách các nhóm, người dùng được kết nối tới máy chủ 

Trong màn hình “Quản trị máy chủ”, từ cửa sổ bên trái chọn “Nhóm và Người dùng”, 
màn hình bên phải sẽ xuất hiện chức năng quản trị nhóm và người dùng. 

 

Chức năng này cho phép người dùng tạo nhóm và người dùng. Chỉ người nào có tên 
truy cập và mật khẩu mới có thể khởi tạo máy chủ hoặc kết nối tới máy chủ. 

 + K. hoạt động: nếu được chọn, tên truy cập này sẽ không được phép kết nối tới máy 
chủ. 

Các tên người dùng có màu xanh, đỏ và được chọn “Đã kết nối” có nghĩa là đã chúng 
đang kết nối tới máy chủ. 
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Thiết lập các quyền cho Nhóm người dùng 

Trong màn hình “Quản trị máy chủ”, từ cửa sổ bên trái chọn “Thiết lập quyền sử 
dụng”, màn hình bên phải sẽ xuất hiện chức năng phân quyền. 

A-Tools thực hiện việc phân quyền theo nhóm, những người trong nhóm đó sẽ có các 
quyền như nhau. 

 

+ Cột đầu tiên, các vùng dữ liệu nào được chọn thì máy khách sẽ nhìn thấy. 

+ Khởi động máy chủ: cho phép nhóm người dùng được khởi động máy chủ để chia 
sẻ các tập tin Excel trong máy tính này qua mạng.  

+ Quản trị máy chủ: cho phép nhóm người dùng được quản trị máy chủ. 

+ Lưu dữ liệu từ xa: cho phép được lưu từ máy khách không. 

+ Chat: cho phép chat với nhau trong mạng không. 

+ Mở vùng K. hoạt động: cho phép mở những vùng có trạng thái “K. hoạt động”. 

Theo ngầm định, các vùng dữ liệu có trạng thái “K. hoạt động” máy khách sẽ không 
mở được. Muốn mở thì nhóm user này phải được phân quyền. Tại máy khách, chọn “Tất cả” 
ở phía trên cây lệnh – cửa sổ bên trái khi đó sẽ nhìn thấy các vùng thuộc loại “K. hoạt 
động”. 

+ Chỉ đọc: nếu chọn, nhóm chỉ xem, không soạn thảo được trong vùng dữ liệu đó 

+ Định dạng: nếu chọn, nhóm sẽ được phép chạy lệnh định dạng vùng tới máy chủ 

+ Sao chép: cho phép nhóm người dùng được copy-sao chép dữ liệu ra ngoài không.  

+ In ấn: cho phép nhóm người dùng được in sheet ra máy in hay các thiết bị khác 
không.  

+ Xác nhận: nếu chọn, nhóm sẽ được chạy chức năng “Xác nhận” để quản trị báo cáo. 
Chức năng này chỉ có hiệu lực nếu CSDL của vùng dữ liệu này được chọn “C&A”. 
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+ Phê chuẩn: nếu chọn, nhóm sẽ được chạy chức năng “Phê chuẩn” để quản trị báo 
cáo. Chức năng này chỉ có hiệu lực nếu CSDL của vùng dữ liệu này được chọn “C&A”. 

Khi người dùng từ máy khách, mở các vùng dữ liệu được cấp quyền “Xác nhận”, “Phê 
chuẩn” thì bên máy khách sẽ có các nút chọn “Xác nhận”, “Phê chuẩn” ở dưới đáy màn 
hình. 

+ Lọc theo: lọc các vùng dữ liệu để phân quyền nhanh theo các dạng. 

Tất cả: hiện ra tất cả các vùng dữ liệu. 

Vùng loại Workbook: chỉ hiện ra các vùng kiểu workbook (cả file). 

Nếu chọn một workbook (file) nào thì sẽ lọc các vùng dữ liệu thuộc workbook đó. 

Các vùng hiện ra còn theo cơ chế xem: All/Active/Inactive của “Server Manager”. 

Chức năng này cho phép lọc dữ liệu nhanh, thao tác phân quyền cho các workbook, 
cho các nhóm nhanh và thuận tiện. 

 

Mỗi nhóm tuỳ vào chức trách riêng sẽ được cấp phát những quyền can thiệp công 
việc ở các mức độ khác nhau. 

Nếu vùng dữ liệu có trạng thái đã xác nhận – “Hủy xác nhận” hoặc đã phê chuẩn –
“Hủy phê chuẩn” thì sẽ không soạn thảo được nữa. 

+ Lưu quyền: Sau khi thiết lập xong bạn cần nhấn nút “Lưu quyền” để xác nhận đã 
xong.  

+ Lưu mẫu: Bạn chọn một tập tin sau đó nhấn “Lưu mẫu” A-Tools sẽ lưu cầu trúc 
phân quyền này vào CSDL của nó, sau này bạn thêm một tập tin có cấu trúc tương tự vào 
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máy chủ thì có thể chọn mẫu thiết lập này vào. Điều này sẽ giảm thời gian thiết lập của 
bạn. 

Quản trị danh sách người dùng kết nối 

Trong màn hình “Quản trị máy chủ”, từ cửa sổ bên trái chọn “Danh sách người dùng 
kết nối”, màn hình bên phải sẽ xuất hiện chức năng quản trị người dùng kết nối. 

Từ danh sách này, máy chủ có thể không hoặc cho phép người đang kết nối tiếp tục 
can thiệp vào máy chủ. Cho phép những người dùng chat với nhau. 

 

Sao lưu dữ liệu 

 

 

 

Chọn nút “Sao lưu…” để mở chức năng “Sao lưu CSDL” 
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TÙY CHỌN 

+ Sao lưu thư mục con của tệp tin: nếu chọn, A-Tools sẽ tạo thư mục con của 

CSDL được sao lưu. 

+ Sao lưu Vùng & Quyền: nếu chọn, A-Tools sẽ sao lưu tất cả các vùng dữ liệu 

chia sẻ và các quyền của nó. 

+ Các tệp tin sao lưu đặt "K. hoạt động": nếu chọn, A-Tools sẽ thiết lập CSDL sao 

lưu về trạng thái “K. hoạt động”. Chức năng này chỉ được thực hiện nếu cả mục “Sao lưu 

Vùng & Quyền” được chọn. 

+ Tên tệp tin mới: tên database sau khi được copy (file mới) được đặt tên theo 

mẫu. A-Tools tự đặt mẫu yyyy-mm-dd [FILENAME]. [FILENAME] là khai báo bắt buộc của     

A-Tools người dùng không được xóa, sửa. 

Để thực hiện việc sao lưu, người dùng chọn nút “Back up”. Khi màn hình “Browse 

For Folder” xuất hiện, người dùng chọn địa chỉ lưu trữ các CSDL sao lưu. 
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Sau khi nhấn nút “Chấp nhận” kết quả sao lưu được hiển thị như màn hình dưới đây: 
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Thay đổi chế độ xem CSDL và quyền 

 

 

Máy chủ quản trị các tệp CSDL với các trạng thái: “K. hoạt động”, “Hoạt động”. 

Nếu muốn hiện hết thì chọn “Tất cả”. Khi người dùng chọn “K. hoạt động” thì của sổ “Cơ 

sở dữ liệu” và “Thiết lập quyền sử dụng” sẽ chỉ hiện dữ liệu là “K. hoạt động”, tương 

tự với việc chọn “Hoạt động”. 

“Tạm dừng” và “Tiếp tục” chạy máy chủ 

Trong một số tính huống như cần bảo trì máy chủ, thiết lập máy chủ thì cần cho 

máy chủ tạm ngừng. Để thực hiện việc này, trong màn hình “Quản trị máy chủ”, người 

dùng nhấn nút “Tạm dừng”. Ngay sau khi nút “Tạm dừng” được chọn, tên của nó (label) 

được đổi thành “Tiếp tục”. 

Khi nút “Tạm dừng” được chọn, máy chủ sẽ không cho bất kỳ yêu cầu kết nối nào 

từ phía máy khách: Đăng nhập; Mở vùng dữ liệu. Máy khách vẫn có thể thực hiện công 

việc soạn thảo bình thường nhưng chưa cập nhật ngay, máy chủ lưu tạm thời trong bộ 

nhớ, chỉ sau khi người dùng chọn “Tiếp tục” trên màn hình “Quản trị máy chủ” trên 

máy chủ thì dữ liệu được cập lật vào ngay lập tức vào CSDL. 



Add-in A-Tools Chia sẻ tập tin Excel qua mạng LAN, Internet 

 

Công ty Cổ phần BLUESOFTS| Nguyễn Duy Tuân – Tel: 04.379.17200 Mobil: 0904210337 18/45 

Website: www.bluesofts.net     Email: sales@bluesofts.net or tuanktcdcn@yahoo.com 

Ngắt kết nối CSDL 

 

Khi một CSDL được các máy khách kết nối tới, trên màn hình “Quản trị CSDL” của 

server sẽ hiện nhữ màu xanh, người dùng chọn file này và nhấn nút “Ngắt kết nối” thì A-

Tools sẽ ngắt kết nối tới tất cả các máy khách. 

Chức năng này cần thực hiện khi người dùng cần thay đổi thiết lập cho CSDL này 

trong máy chủ và không muốn các máy khách truy xuất vào khi nó đang thiết lập. 

Chức năng này thường được thực hiện cùng với chức năng “Tạm dừng”. 

Tắt máy chủ 

Từ menu A-Tools, chọn “Tắt máy chủ”. 

 

Lưu ý: người dùng chỉ có thể đóng các tệp dữ liệu sau khi đã tắt máy chủ. 

Chức năng máy khách (Excel Client) 

Kết nối tới máy chủ 

Từ menu A-Tools, bấm chọn chức năng “Kết nối”  
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+ Tên máy chủ: người dùng có thể nhập tên hoặc địa chỉ IP của máy chủ, người dùng 
nên nhập địa chỉ IP để kết nối. 

+ Tên người dùng: tên hệ thống cung cấp ban đầu là “user”. 

+ Mật khẩu: với tên “user” thì mật khẩu để trống. 

Chỉ những người có tên truy cập (tài khoản) và mật khẩu thì mới chạy được chức năng 
máy chủ và máy khách (Excel Network: Excel Server; Excel Client). 
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Kết nối vào vùng dữ liệu trong trong máy chủ 

Sau khi kết nối tới máy chủ thành công, người dùng sẽ mở được danh sách các vùng 
dữ liệu mà mình được phép kết nối. Việc người dùng có thể sửa, xoá, định dạng trong vùng 
tuỳ thuộc vào quyền được cấp trong nhóm. 

Người dùng có thể mở vùng dữ liệu từ menu A-Tools chọn ”Quản trị máy khách”. 

 

Để mở một vùng, chọn vùng cần mở sau đó chọn nút “Mở vùng”. 

A-Tools quản lý 3 loại vùng:  

 Vùng địa chỉ (Range) - cho phép soạn thảo trong các vùng địa chỉ đã định. 
 Vùng bảng tính (Sheet) – cho phép soạn thảo trong toàn bộ bảng tính. 
 Vùng workbook – cho phép xem và soạn thảo trong toàn bộ workbook. Nếu 

máy chủ vừa chia sẻ workbook vừa cả các sheet trong nó thì workbook chỉ 
cho đọc mà thôi (Read-Only). Muốn soạn thảo được phải mở sheet hoặc vùng 
(Range). 

Lưu ý: Nếu một tệp CSDL mà vừa có vùng địa chỉ vừa có vùng bảng tính và vùng 
workbook thì nếu người dùng mở vùng workbook thì chỉ có thể xem được mà không soạn 
thảo được. Quyền của một vùng phụ thuộc vào quyền của vùng cấp cao hơn. Ví dụ quyền 
của vùng địa chỉ phụ thuộc vào quền của vùng bảng tính và workbook. 

Để đóng vùng đang mở, chọn vùng đang mở (có màu xanh) sau đó chọn nút “Đóng 
vùng”. 

Nếu mở vùng dữ liệu thành công, người dùng sẽ thấy được vùng dữ liệu như hình 
dưới đấy. 
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+ Nếu chọn nút “Xác nhận” thì những người dùng khác trong mạng không thể sửa 
nhưng có thể in vùng dữ liệu này tùy theo quyền được in. 

+ Nếu chọn nút “Phê chuẩn” thì những người dùng khác trong mạng không thể sửa 
nhưng được in vùng dữ liệu này. 

Chức năng “Xác nhận” và “Phê chuẩn” chỉ có hiệu lực nếu CSDL của nó được chọn 
“C&A” và người dùng mua bản quyền chức năng “Quản trị báo cáo” của A-Tools Pro. 
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Khi các máy tính kết nối vào mạng thì có thể soạn thảo chung vào một vùng dữ liệu 
trong máy chủ. 

 

http://www.bluesofts.net/Products/AddIns/A-Tools/Pics/ExcelCaro.gif 

 

Quản trị danh sách người dùng kết nối 

Trong màn hình “Quản trị máy khách”, từ cửa sổ bên trái chọn “Danh sách người 
dùng kết nối”, màn hình bên phải sẽ xuất hiện chức năng quản trị người dùng kết nối. 

Từ danh sách này người dùng có thể chat với những người có trong danh sách. 
Những người có trong danh sách là những người đang kết nối tới máy chủ. 

Các chức năng hỗ trợ soạn thảo và cập nhật dữ liệu lên máy chủ 

 

 

 

+ Xem thay đổi: nếu được chọn, khi máy tính từ xa thay đổi giá trị tại địa chỉ ô nào đó 
thì máy của người dùng sẽ chọn ô đó và thông báo sự thay đổi. Chức năng này chỉ nên 
dùng khi người dùng cần theo dõi con trỏ ô của máy tính khác đang kết nối chung một vùng 
dữ liệu. 

+ Tự động cập nhật: nếu chọn (ngầm định), khi người dùng thay đổi giá trị trong 
vùng kết nối thì máy chủ sẽ cập nhật ngay. 

http://www.bluesofts.net/Products/AddIns/A-Tools/Pics/ExcelCaro.gif
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Nếu dữ liệu soạn thảo không nhất thiết phải cập nhật ngay lên máy chủ thì người 
dùng nên bỏ chọn để đảm bảo tốc độ soạn thảo nhanh hơn. Khi cần cập nhật dữ liệu lên 
máy chủ, chỉ cần chọn vùng dữ liệu cần cập nhật, chọn “Cập nhật dữ liệu”. Nếu muốn cập 
nhật định dạng thì chọn “Cập nhật định dạng”. Nếu muốn cập nhật cả giá trị lẫn định dạng, 
chọn “Cập nhật định dạng và dữ liệu”.  

Tùy chọn cho A-Tools 

Từ menu A-Tools, chọn nút “Tùy chọn” hoặc tại màn hình “Quản trị máy chủ/khách” 
chọn mục “Tùy chọn”. 

 

+ “Chia sẻ Visual Basic for Application” – Máy khách có thể sử dụng macro từ file 
trong máy chủ. Chọn mục này,  người quản trị máy chủ cần kiểm tra kỹ lưỡng trước khi cho 
người dùng kết nối! 

+ “Mở CSDL nếu máy khách yêu cầu”: nếu được chọn, khi khởi động máy chủ A-

Tools không mở các database dạng (active), database chỉ được mở nếu máy khách yêu 

cầu kết nối, khi máy khách ngắt kết nối thì máy chủ sẽ kiểm tra database này xem còn 

máy khách nào kết nối nữa không, nếu không sẽ tự đóng database này lại. 

Tính năng này tối ưu cho máy chủ, tiết kiệm bộ nhớ RAM, tốc độ chạy nhanh hơn. 

Đây là giải pháp tối ưu máy chủ. 
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Lưu ý: khi chọn chức năng này người dùng cần đảm bảo các database thực sự mở 

được bình thường, không đặt cơ chế bảo mật gì tới việc mở, cấu trúc. Nếu database 

(workbook) bị đặt mật khẩu mở hoặc bảo về cấu trúc workbook thì A-Tools không làm 

việc được. 

+ “Tự cập nhật công thức”: nếu KHÔNG chọn, các công thức trong các sheet ở 

máy chủ không tự tính lại khi có sự thay đổi dữ liệu, tuy nhiên ở các máy khách đang mở 

thì vẫn tính lại. Đây là giải pháp tối ưu máy chủ vì giúp máy chủ hoạt động nhanh và nhẹ 

hơn.  

+ “Ẩn Microsoft Excel khi khởi động”: nếu được chọn, khi tạo máy chủ thì màn 

hình Micrsoft Excel bị ẩn hoàn toàn, có biểu tượng nằm ở khu vực TrayBar – Đấy góc phải 

màn hình máy tính. Có thể nhấp chuột phải vào biểu tượng này để chạy các chức năng 

máy chủ. 

 

+ “Thêm các sheets khi thêm workbook”: nếu được chọn, tại màn hình “Quản trị 

vùng kết nối”, khi thêm file vào máy chủ, A-Tools tự thêm cho bạn toàn bộ các sheet có 

trong file đó. 

+ “Số lượng máy kết nối tối đa”: xác định số máy khách được phép kết nối tới máy 

chủ. 
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+ “Thời gian cập nhật giá trị”: xác định thời gian là mili giây cập nhật giá trị từ máy 

khách lên máy chủ. Thiết lập chuẩn là 100 mili giây. 

+ “Lưu các tệp tự động khi dừng máy chủ”: nếu được chọn, khi tắt máy chủ toàn 

bộ các tệp Excel mà máy chủ quản lý tự lưu lại. 

+ “Lưu các tệp sau n phút”: nếu được thiết lập, máy chủ sẽ tự lưu các tệp đang 

chia sẻ định ký n phút một lần. 

+ “Cổng kết nối (Port)”: cổng ngầm định trong A-Tools là 1711. Vì lý do nào đó 

cần thay đổi, bạn hãy nhấp đúp chuột vào để thay đổi. Để A-Tools chia sẻ dữ liệu qua 

Internet, bạn cần phải dùng kỹ thuật mở cổng trong modem. Nếu cần trợ giúp bạn hãy 

liên hệ với phong hỗ trợ khác hàng Công ty cổ phần BLUESOFTS. 

+ “Cấp của thư mục”: xác định cấp thư mục ở cửa sổ bên trái để tiện quản lý cây 

thư mục chưa CSDL trong máy chủ. 

Để lưu các thiết lập vào hệ thống bạn phải nhấp nút “Chấp nhận”. 

Ngắt kết nối tới máy chủ 

Từ menu A-Tools, chọn “Ngắt kết nối”. 

 

Để dễ dàng thực hành với chức năng chia sẻ tệp Excel qua mạng bằng A-Tools, bạn 
có thể tham khảo các video clip của chúng tôi tại địa chỉ sau: 

 

http://bluesofts.net/giai-phap-phan-mem/a-tools-truy-van-loc-soan-thao-va-quan-tri-du-lieu-
excel-qua-mang/186-video-a-tools.html 

 

  

http://bluesofts.net/giai-phap-phan-mem/a-tools-truy-van-loc-soan-thao-va-quan-tri-du-lieu-excel-qua-mang/186-video-a-tools.html
http://bluesofts.net/giai-phap-phan-mem/a-tools-truy-van-loc-soan-thao-va-quan-tri-du-lieu-excel-qua-mang/186-video-a-tools.html
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Hướng dẫn truy vấn (lọc) dữ liệu trong bảng tính Excel

“SQL Builder” và hàm “BS_SQL” 
(Trong tài liệu này chúng tôi chỉ nói sơ lược mang tính giới thiệu tổng thể. Chi tiết về 

cách sử dụng hàm BS_SQL cũng như các phương pháp trích lọc dữ liệu xem hướng dẫn tập 
tin: C:\A-Tools\Documents\A-Tools_Query_Report_Help.pdf ) 

A-Tools sử dụng hàm BS_SQL để lọc dữ liệu và làm báo cáo. Hàm BS_SQL sử dụng 
câu lệnh T-SQL kết hợp với các hàm của A-Tools để lọc dữ liệu và làm báo cáo một cách linh 
hoạt và mạnh mẽ. Dữ liệu có thể móc nối từ nhiều bảng có quan hệ và có thể từ nhiều loại 
cơ sở dữ liệu (CSDL) khác như: Excel, Access, Foxpro, MS SQL, MySQL, Firebird, ….Mặc dù 
dữ liệu được lọc vào bảng tính Excel có thể từ nhiều nguồn nhưng chúng được liên kết với 
nhau, dữ liệu gốc thay đổi thì báo cáo thay đổi theo. 

 

 
 

 

file:///C:/A-Tools/Documents/A-Tools_Query_Report_Help.pdf
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Đặt tên vùng dữ liệu trong bảng tính Excel (worksheet) 

Trong bảng tính có nhiều vùng dữ liệu, A-Tools lọc dữ liệu từ các vùng này. 

Ví dụ lọc lấy các chứng từ trong sheet “KHO”, vùng dữ liệu A3:K68. 

Đặt công thức: 

=BS_SQL("SELECT * FROM [KHO$A3:K68]") 

Nếu vùng dữ liệu được đặt tên là KHO (=KHO!A3:K68) thì công thức như sau. 

=BS_SQL("SELECT * FROM KHO") 

Việc đặt tên đem lại hiệu quả sử dụng rất cao trong các công thức Excel. Với A-
Tools, tên của một vùng KHO được coi như tên của một bảng (table) trong CSDL 
Excel. 

Cách tạo tên cho vùng dữ liệu 

Người dùng làm theo trình tự sau:  

+ 1: Chọn vùng dữ liệu 

+ 2: Chọn menu “Formula” (Với Excel 2007 hoặc cao hơn) 

+ Chọn menu “Insert->Name” (Với Excel 2003 hoặc thấp hơn) 

+ 3: Chọn “Define Name” 

 

+ Name: đặt tên vùng KHO 

+ Refers to: địa chỉ tham chiếu. Excel tự điền. 

Sau khi nhập tên xong, nhấn nút “Ok” để hoàn tất. 
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Tạo công thức BS_SQL bằng “SQL Builder” 

Từ menu “A-Tools” chọn “SQL Builder” 

Với Excel 2003 vào menu “A-Tools”->“Truy vấn dữ liệu” chọn “SQL Builder” 

 

 

(Để liên kết giữa bảng KHO và DMHH, nhấp chuột vào MA_VLSPHH bên KHO kéo sang 
MA_VLSPHH của bảng DMHH rồi nhả chuột) 

(1) DBKEY – Khóa kết nối: chọn CSDL hoặc DBKEY (mã kết nối với CSDL bên ngoài). Để 
kết nối với CSDL bên ngoài, người dùng phải tạo DBKEY, cách tạo sẽ hướng dẫn ở 
trang sau. 

(2) Danh sách các tên vùng hoặc tên bảng (table, query) dữ liệu trong CSDL chọn ở (1).  
Người dùng hãy nhấp đúp chuột hoặc kéo tên vùng dữ liệu từ (2) sang (3) để làm 
nguồn dữ liệu. 

(3) Nối các khóa quan hệ giữa các bảng (table) nếu có (trong hình vẽ là “MA_VLSPHH”). 
Chọn các trường dữ liệu để hiển thị và làm điều kiện. 

(4) + Output: nếu chọn, trường dữ liệu đó sẽ hiển thị 

+ Expression: tên trường dữ liệu hoặc biểu thức tính 

1 

2 
3 

4 

5 
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+ Aggregate: chọn tên hàm thống kê: Sum; Count; Min; Max;… 

+ Alias: đặt tên cho trường hoặc biểu thức ở “Expression” 

+ Sort Type: chọn kiểu sắp xếp tăng (Ascending) hay giảm (Descending) dần 

+ Sort Order: đặt ưu tiên trường sắp xếp 

+ Grouping: chọn các trường dữ liệu được nhóm theo. Mục này được sử dụng khi 
người dùng chỉ định hàm thống kê ở “Aggregate”. Tất cả các trường nếu không có 
chỉ định hàm thống kê thì ần được chọn “Grouping”. 

Criteria: mục đặt điều kiện lọc. Người dùng có thể dùng chuột để chọn dữ liệu trong 
một ô của bảng tính làm điều kiện động, thực chất là sử dụng hàm RANGE(..). 

(5) Sau khi thực hiện 4 mục trên, A-Tools sẽ tự động tạo câu lệnh T-SQL cho hàm 
BS_SQL. 

Sau khi thiết lập xong, người dùng chọn nút “Tiếp tục” sẽ xuất hiện màn hình dưới đây 

 

+ Tên bảng kết quả: A-Tools sẽ tự động tạo tên cho vùng kết quả. 

+ Tự động tạo tên các cột: A-Tools tự đặt tên các vùng theo mỗi cột trong vùng kết quả. 
Những tên được tạo sẽ được sử dụng trong các công thức của Excel. 

+ Chèn dòng: nếu được chọn, bảng kết quả sẽ chèn các dòng dữ liệu sau con trỏ. Nếu 
không, dữ liệu dẽ bị ghi đè lên. 

+ Địa chỉ đặt tham số SQL: ô chứa câu lệnh SQL. Cần thiết sử dụng khi chuỗi lệnh SQL dài 
(số ký tự > 128 ký tự). 
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+ Địa chỉ ô/vùng đặt công thức: ô đầu tiên trong bảng tính chứa giá trị của bảng kết quả. 

Sau khi hoàn tất, chọn nút “Thực hiện” để A-Tools chạy hàm BS_SQL trong bảng tính. 

Công thức có hàm BS_SQL được tạo ra bởi “SQL Builder” như sau: 

=BS_SQL("SELECT DMHH.TEN, Sum(KHO.SLG) AS SLG 

              FROM DMHH INNER JOIN KHO ON KHO.MA_VLSPHH = DMHH.MA_VLSPHH 

   GROUP BY DMHH.TEN, KHO.LOAI_PHIEU 

      HAVING KHO.LOAI_PHIEU = 'N'" , "INSERT=YES; AutoNames(THHH);") 

 Xem hướng dẫn bằng video tại đây: 

http://www.bluesofts.net/Products/AddIns/A-Tools/Help/DEMO/Index.htm 

Hướng dẫn sử dụng hàm BS_SQL 

Hàm BS_SQL trong A-Tools là một hàm đa năng và rất đặc biệt. Kết quả trả về của 
hàm là một bảng dữ liệu được lọc theo các điều kiện phức tạp, dữ liệu được móc nối với 
nhau mà nguồn dữ liệu có thể từ nhiều loại CSDL khác. Chỉ cần một hàm BS_SQL, người 
dùng có thể tạo ra các loại báo cáo động. 

Hàm BS_SQL có cấu trúc: 

BS_SQL(SQL [,OPTIONS]) 

+ SQL: Là một chuỗi khai báo câu lệnh truy vấn SQL. SQL là một ngôn ngữ truy vấn 
CSDL như trong Access, Foxpro, dBASE, SQLServer, Oracle… 

Câu lệnh SQL trong hàm BS_SQL được phối hợp thêm các hàm: RECNO, CELL, 
RANGE, DATA, GetOnce, FORMULA, FieldIf, VTC,…Nhờ phối hợp các hàm này trong khai báo 
SQL, hàm BS_SQL có thể trả về kết quả rất linh động. 

+ OPTIONS: Là tham số tuỳ chọn (có thể không có), tham số này là một chuỗi, cho 
phép khai báo thêm các tham số cho hàm, các tham số được ngăn cách nhau bởi 
dấu chấm phảy (;) 

Các tham số sử dụng trong OPTIONS bao gồm: DBKEY, HR, NAME, AUTONAMES, INSERT, 
SERVERSOURCE. 

Có thể lập trình các macro trong VBA để chạy trong các sự kiện của hàm BS_SQL, khai báo 
chạy các macro thực hiện trong tham số OPTIONS. Các tham số được khai báo như sau: 

+ Cho phép chạy một macro trước khi cập nhật dữ liệu vào bảng tính 

  OnBeforeUpdate = YourMacro 

+ Cho phép chạy một macro sau khi dữ liệu được cập nhật 

  OnAfterUpdate = YourMacro  

+ Cho phép chạy một macro khi nhấp đúp chuột vào vùng dữ liệu (có hàm BS_SQL) 

  OnDblClick = YourMacro 

+ Cho phép chạy một macro khi con trỏ ô di chuyển 

  OnSelectionChange = YourMacro 

+ Cho phép chạy một macro (hàm) để thay đổi giá trị trong quá trình nhận dữ liệu từ 
kết quả truy vấn SQL. 

  OnGetValue = YourMacro 

http://www.bluesofts.net/Products/AddIns/A-Tools/Help/DEMO/Index.htm
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Ví dụ: lấy toàn bộ dữ liệu sổ kho vào bảng tính Excel, sổ kho nằm trong tệp 
Access “Examble.mdb” đã được kết nối với mã DBKEY là MDB. 

=BS_SQL(“SELECT * FROM KHO” , “DBKEY=MDB”) 

Tham số SERVERSOURCE dùng để lấy dữ liệu từ máy chủ. 

Ví dụ: 

=BS_SQL(“SELECT * FROM KHO” , “DBKEY=MDB; SERVERSOURCE=YES”) 

 

Nguyên tắc làm việc của hàm BS_SQL trong tập tin chia sẻ qua mạng 

Hàm BS_SQL trong tập tin Excel được chia sẻ qua mạng có nguyên tắc như sau: 

+ Tại máy chủ: không tự động chạy, ở chế độ đóng băng. Đây là đặc điểm giúp cho máy 
chủ tiết kiệm bộ nhớ và chạy nhanh hơn. Bạn có thể tự cập nhật bằng cách đặt con trỏ vào 
vùng công thức nhấn lệnh “Cập nhật” trên menu A-Tools hoặc nhấn tổ hợp phím 
CTRL+SHIFT+A. 

+ Tại máy khách: chạy và cập nhật bình thường. Dữ liệu truy vấn là tại máy chủ. 

 có thể tham khảo các video clip của chúng tôi tại địa chỉ sau: 

Tạo DBKEY – Kết nối dữ liệu bên ngoài 

A-Tools cho phép kết nối với các CSDL ngoài: Access, Foxpro, MS SQL, MySQL,…Để 
kết nối vào Excel, người dùng phải tạo DBKEY. 

Từ menu “A-Tools” chọn “SQL Builder” 

Với Excel 2003 vào menu “A-Tools”->“Truy vấn dữ liệu” chọn “DBKEY - Thiết lập các 
kết nối với CSDL bên ngoài” 

 

Sau khi màn hình hiện ra, nhấn nút “Thêm” sau đó chọn loại CSDL cần kết nối vào mã 
DBKEY. 
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+ DBKEY: mã của kết nối. Tên DBKEY được sử dụng trong các hàm của A-Tools như 
BS_SQL, BS_TABLE,… 

+ Thêm: tạo thêm DBKEY (thêm kết nối) 

+ Sửa: sửa lại các thong số thiết lập DBKEY 

+ Gỡ bỏ: gỡ bỏ DBKEY khỏi A-Tools. Nếu DBKEY bị gỡ bỏ, các công thức sử dụng tới 
DBKEY này đều bị lỗi. 

Ví dụ: 

Truy vấn dữ liệu sổ kho, với loại chứng từ là nhập „N‟ 

1) Sổ kho nằm ở tại tệp đang mở 
=BS_SQL(“SELECT * FROM KHO WHERE LOAIPHIEU=‟N‟ ”) 

2) Sổ kho nằm ở tệp CSDL Access “Examble.mdb”.  
Ta đã tạo DBKEY với tên MDB kết nối tới “Examble.mdb” 

=BS_SQL(“SELECT * FROM KHO WHERE LOAIPHIEU=‟N‟ ” , “DBKEY=MDB”) 
 
 

Truy vấn, nhận dữ liệu từ máy chủ bằng hàm BS_SQL() 

Khi máy chủ đang mở. Từ máy khách dùng hàm BS_SQL với việc gán thuộc tính 
SERVERSOURCE=YES để nhận dữ liệu từ máy chủ. 

Giả sử máy chủ đang chạy và đang mở một workbook có vùng dữ liệu tên là “KHO”. 
Cách viết hàm như sau: 

=BS_SQL("SELECT * FROM KHO" , "SERVERSOURCE=YES") 

Nếu máy chủ quản lý sổ “KHO” trong CSDL Access và được kết nối bởi mã DBKEY có 
tên "MDB" 

=BS_SQL("SELECT * FROM KHO" , "DBKEY=MDB; SERVERSOURCE=YES") 
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Với hai ví dụ trên, thay vì lấy dữ liệu trong máy khách, người dùng có thể lấy dữ liệu 
từ máy chủ. Việc viết hàm BS_SQL() như cách thức cũ chỉ cần thêm khai báo trong tham số 
OPTIONS là SERVERSOURCE=YES 

 

Máy chủ chia sẻ tập tin Excel có liên kết tới dữ liệu của các tập tin 
Excel khác 

Add-in A-Tools không cho phép máy chủ chia sẻ tập tin Excel mà nó có liên kết tới các 
tập tin Excel khác. Để khắc phục điều này ta dùng hàm BS_SQL kết nối qua DBKEY. 

Giả xử tập tin “fileB.xls” có công thức liên kết tới tập tin “fileA.xls” – Tập tin nguồn. 
Trình tự làm tại máy chủ như sau: 

Bước 1: Tạo DBKEY có mã “DL” (hoặc mã nào bạn muốn) kết nối tới tập tin có dữ liệu 
chia sẻ 

Tập tin có dữ liệu chia sẻ là “fileA.xls” như hình dưới đây. 

 

Bạn cần tạo tên cho những vùng dữ liệu (Define Name) cần chia sẻ (fileB.xls cần lấy). 
Ví dụ tạo tên là “DMVLSPHH”. 

Tạo DBKEY với mã “DL” kết nối vào tập tin này. 

 

Sau khi màn hình hiện ra, nhấn nút “Thêm” sau đó chọn loại CSDL Excel, chọn tập tin tên là 
“fileA.xls”, tạo mã DBKEY là “DL”. 
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Bước 2: Từ tập tin “fileB.xls” có công thức liên kết, tạo một sheet trung gian như là “BS_SQL 
External Data”, nhập hàm BS_SQL để lấy dữ liệu trong DBKEY “DL” chính là kết nối vào 
“fileA.xls”.  

Dùng công thức: 

=bs_sql("SELECT * FROM DMVLSPHH", "DBKEY=DL; NAME=DMHH") 

 

 DBKEY=DL để lấy dữ liệu trong “fileA.xls” 
 NAME=DMHH để bảng kết quả được đặt tên DMHH. Tên vùng này tham chiếu tới 

bảng kết quả và nó được sử dụng cho các mục đích khai thác dữ liệu của tập tin 
“fileB.xls”. 

Bước 3: Khai thác dữ liệu bằng các hàm Excel thông thường 

Trong tập tin “fileB.xls”, tại sheet “Formula Linking” lấy dữ liệu từ vùng DMHH. 

Ví dụ dùng công thức: =VLOOKUP(B2, DMHH,2,FALSE) 
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Với cách làm trên “fileB.xls” đã liên kết dữ liệu với “fileA.xls” và được máy chủ cho phép chia 
sẻ qua mạng. Không những vậy, với cách này bạn hoàn toàn có thể liên nhiều nguồn dữ liệu 
từ các tập tin Excel khác hoặc các loại CSDL khác. 

 

Tóm tắt quá trình làm bằng mô hình như sau: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

  

Tập tin Excel nguồn 
(“fileA.xls”) 

nhập dữ liệu 

Tập tin Excel (“fileB.xls”) 
Lấy dữ liệu  

 

DBKEY 

“DL” 

BS_SQL(“SELECT…”, “DBKEY=DL; NAME=DMHH”) 

Khai thác dữ liệu trong vùng DMHH 
Ví dụ: =VLOOKUP(..,DMHH,..) 
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Các câu hỏi thường gặp liên quan đến máy chủ, máy khách, không 
cập nhật dữ liệu được 

1. Tại sao máy khách không nhập được dữ liệu? 

Trả lời: 

Lý do 1: 

 Vùng địa chỉ (Range) - cho phép soạn thảo trong các vùng địa chỉ đã định. 
 Vùng bảng tính (Sheet) – cho phép soạn thảo trong toàn bộ bảng tính. 
 Vùng workbook – cho phép xem và soạn thảo trong toàn bộ workbook. Nếu 

máy chủ vừa chia sẻ workbook vừa cả các sheet trong nó thì workbook chỉ 
cho đọc mà thôi (Read-Only). Muốn soạn thảo được phải mở sheet hoặc vùng 
(Range). 

Lý do 2: 

 Vùng, sheet đang bị đặt ở chế độ “Check” – Xác nhận hoặc “Approval”-Phê 
duyệt. 

 Ví dụ hình dưới đây chỉ ra 4 vùng đều không soạn thảo được: 

 

 + “Shop.xls” không soạn thảo được vì nó là loại workbook, và máy chủ chia 
sẻ các sheet, vùng của nó. Bạn chỉ có thể mở để xem. Muốn soạn thảo dduwwocj thì 
không chia sẻ các sheet và các vùng bên trong nó. 

 + “Shop 1” không soạn thảo được vì nó đang bị đặt “Xác nhận” 

+ “Items_A5_B105” không soạn thảo được vì nó đang bị đặt “Phê Chuẩn” 

+ “Shop 1_A9_F30” không soạn thảo được vì nó đang bị đặt “Xác nhận”  và “Phê 
Chuẩn”. 

Lý do 3: Vùng dữ liệu bị phân quyền “Chỉ đọc”-Read-Only 
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+ Vùng dữ liệu “Shops.xls” không bị chọn là “Chỉ đọc” nhưng không soạn thảo được 
vì nó là dạng workbook và máy chủ chia sẻ các sheet và các vùng bên trong nó. 

+ Vùng dữ liệu “Shop 1” bị chọn là “Chỉ đọc” vì thế máy khách không soạn thảo 
được. 

2. Tại sao máy khách không nhìn thấy các workbook, sheet, vùng dữ liệu trong máy 
chủ? 

Trả lời: Tên truy cập của bạn thuộc nhóm có phân quyền không mở với các loại dữ 
liệu đó. 

3. Máy tính nào cũng có thể làm máy chủ? 

Trả lời: Máy tính nào cũng được, dù chạy Windows thường. Chỉ cần cấu hình đủ 
mạnh để làm việc. Bạn nên chọn máy có cấu hình cao nhất để làm máy chủ. 

4. Người dùng tại máy khách có thể copy dữ liệu chia sẻ từ máy chủ ra nơi khác? 

Trả lời: Không. Nếu trong máy chủ bạn phân quyền nhóm user này không được 
copy. 

5. Máy chủ không nhìn thấy tập tin Excel đã nạp vào để chỉ sẻ? 

Trả lời: Do đặt chế độ “Inactive” – Không hoạt động. Ở phía trên cửa sổ bên trái bạn 
chọn xem “Tất cả”. Sau đó bỏ chọn mục “Inactive” – K. Hoạt động. 
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6. Máy khách không thể mở vùng dữ liệu trong máy chủ? 

Trả lời:  

Lý do 1: Do máy chủ đặt giới hạn số người kết nối tới vùng dữ liệu này. Nếu số 
người kết nối quá số lượng cho phép sẽ thì sẽ không mở được nữa. 

 

 Ở cột “Slg kết nối” nếu để -1 sẽ không giới hạn số người kết nối. 

Lý do 2: Do máy chủ đang bận, hãy ngắt kết nối máy khách và kết nối lại. 

7. Máy khách không thể kết nối tới máy chủ? 

Trả lời:  

Lý do 1:  

+ Do máy chủ chưa bật  
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+ Do sai tên hoặc địa chỉ IP, tên miền của máy chủ. Nếu trong mạng LAN nên nhập 
chính xác địa chỉ IP, không nên dùng tên máy chủ vì có thể tên bị trùng giữa các 
máy tính trong mạng LAN. 

+ Đường mạng không ổn định. 

Lý do 2: Do máy chủ bị giới hạn số lượng kết nối ở mục “Options” – Tùy chọn. Bạn 
hãy tăng số lượng kết nối lên. Nếu tăng không được có thể license của bạn không 
hợp lệ. 

 

8. Mặc dù đã phân quyền cho người dùng được soạn thảo trong một sheet nhưng 
máy khách vẫn không soạn thảo được công thức? 

Trả lời:  

Lý do 1: Do trong sheet này bạn đặt chế độ protect sheet. Vậy bạn cần Unprotect 
sheet (gỡ bỏ bảo mật sheet trong Excel). 

Lý do 2: Do trong sheet này, ở vùng dữ liệu có công thức bạn đặt Protection và chọn 
Hidden. Giống hình dưới đây. 
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Nếu bạn định dạng vùng dữ liệu là Protection->Hidden như hình trên sau đó đặt 
Protect Sheet thì máy khách sẽ không thể soạn thảo được công thức dù không chọn 
“Locked”. 

Cách khắc phục là KHÔNG chọn mục Hidden. 

Hướng dẫn các chức năng khác của A-Tools  

Tạo công thức mảng – Formula Array 

Add-in A-Tools cung cấp công cụ tạo công thức thông kê có nhiều điều kiện, tất cả 
mọi việc thực hiện rất đơn giản, chỉ cần vài cú nhấp chuột bạn đã có một công thức Excel, 
mà nếu bình thường phải mất nhiều thời gian để làm mà chưa chắc kết quả đã như mong 
đợi. Qua công cụ này bạn sẽ tự phát triển được khả năng tạo công thức trên Excel. 

Bước 1: Chọn vùng dữ liệu, gồm cả dòng tiêu đề. 
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Bước 2: Chọn menu A-Tools->”Tạo công thức” 

 

Sau khi chọn “Tạo công thức” sẽ xuất hiện màn hình dưới đây. Chọn lại vùng dữ liệu 
cần tính nếu muốn thay đổi. 

 

 

Bước 3: Chọn menu A-Tools->”Tạo công thức” 
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Theo màn hình trên, thực hiện các bước:  

1. Chọn hàm, ví dụ SUM 
2. Chọn cột cần tính toán, ví dụ THANH_TIEN 
3. Chọn cột làm điều kiện, ví dụ MA_VLSPHH 
4. Chọn giá trị so sánh: “HH001” 
5. Chọn nút “Thêm”. Nếu cần thêm các điều kiện thì lại lập lại từ 3.->5. 
6. Chọn “Tiếp” để chuyển màn hình kế tiếp. 

Bước 4: Chọn ô đặt công thức và copy. 

 

+ Ô kết quả: là địa chỉ đặt công thức 
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+ Copy to: nếu công thức này cần copy cho vùng khác thì chọn vùng cần copy 

Sau khi chọn “Kết thúc” A-Tools tạo cho bạn công thức mảng như hình dưới đây. 

Đây là công cụ cho phép tạo công thức Excel có độ phức tạp mà chỉ cần dùng chuột là 
xong. 

 

Hàm đọc số thành chữ 
Hàm BS_VND 
Hàm cho phép đọc số thành chữ theo tiếng Việt 
Cấu trúc: 

BS_VND(Amount, OutputType, Unit1, Unit2, MUnit2, HasGroupingSymbol)  

 Amount : là số tiền cần chuyển đổi thành văn bản. 
 OutputType : là một số, nếu giá trị là 1 hàm trả về kiểu chuỗi TCVN3, 2 kiểu chuỗi 
là VNI, 3 kiểu chuỗi là Unicode - ngầm định (Chỉ dùng từ Excel 2007 trở lên) 
 Unit1  : là giá trị kiểu chuỗi, chỉ ra loại đơn vị tiền tệ, ngầm định là "đồng" 
 Unit2  : là giá trị kiểu chuỗi, chỉ ra loại đơn vị tiền tệ cho số lẻ, ngầm định là 
"xu" 
 MUnit2 : là con số được nhân với số lẻ của Amount, quy đổi số lẻ từ đơn vị Unit1 
sang Unit2, ngầm định giá trị là 1 
 HasGroupingSymbol:  là giá trị kiểu logic(boolean), nếu là TRUE thì chuỗi kết quả sẽ 
có dấu phảy (, ) ngăn cách câu, FALSE là giá trị ngầm định không có dấu (, ) ngăn cách. 
  
Giả xử ô B2 có số tiền là: 12345.53 

=BS_VND(B2)  Mười hai ngàn ba trăm bốn mươi lăm đồng và năm mươi ba xu. 
Muốn làm tròn thì dùng hàm ROUND kết hợp: 

=BS_VND(ROUND(B2,0))  Mười hai ngàn ba trăm bốn mươi sáu đồng chẵn. 
+ Cách đọc số tiền với các loại font chữ 
=BS_VND(B2, 1)  Mêi hai ngµn ba tr¨m bèn m¬i l¨m ®ång vµ n¨m m¬i ba xu. 
=BS_VND(B2, 2)  Möôøi hai ngaøn ba traêm boán möôi laêm ñoàng vaø naêm möôi ba 
xu. 

=BS_VND(B2, 3)  Mười hai ngàn ba trăm bốn mươi lăm đồng và năm mươi ba xu. Tương 
đương với công thức =BS_VND(B2) 
+ Thay đổi đơn vị tính 
=BS_VND(B2,,"USD","CENTS"))  Mười hai ngàn ba trăm bốn mươi lăm USD và năm mươi 
ba CENTS. 
+ Quy đổi đơn vị: 

=BS_VND(B2,,"HOUR(S)","MINUTE(S)",60) Mười hai ngàn ba trăm bốn mươi lăm 
HOUR(S) và ba mươi hai MINUTE(S). 
=BS_VND(B2,,"HOUR(S)","MINUTE(S)",60,1)  Mười hai ngàn, ba trăm bốn mươi lăm 
HOUR(S) và ba mươi hai MINUTE(S). 

Hàm BS_USD 
Hàm cho phép đọc số thành chữ theo tiếng Anh 
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Cấu trúc: BS_USD(Amount, Unit1, Unit2, MUnit2, HasGroupingSymbol)  
Cách sử dụng về cơ bản giống hàm BS_VND 
Ví dụ:  
 =BS_USD(B2)  Kết quả là: Twelve thousand three hundred and forty five dollars and fifty 
three cents. 

Hàm chuyển mã văn bản 
=UNC - Hàm chuyển từ mã TCVN3 thành Unicode 
=UNC("Anh ch¼ng muèn") Kết quả "Anh chẳng muốn" 
  
UnicodeToTCVN3 - Chuyển từ mã Unicode sang TCVN3 
UnicodeToVni - Chuyển từ mã Unicode sang VNI 
VniToUnicode - Chuyển từ mã VNI sang Unicode 
VniToTcvn3 - Chuyển từ mã VNI sang TCVN3 
Tcvn3ToVNI  - Chuyển từ mã TCVN3 sang VNI 
Tcvn3ToUnicode - Chuyển từ mã TCVN3 sang Unicode 
  
Hàm chuyển mã tổng hợp  

ConvertStr(StringToConvert , nActionType) 

StringToConvert  : Là chuỗi để chuyển mã 
nActionType  : Là mã chuyển. Có thể nhận 1 trong các giá trị số dưới đây: 

2 - Chuyển từ mã Unicode sang TCVN3 
3 - Chuyển từ mã Unicode sang VNI 
4 - Chuyển từ mã VNI sang Unicode 
5 - Chuyển từ mã VNI sang TCVN3 
1 - Chuyển từ mã TCVN3 sang VNI 
6 - Chuyển từ mã TCVN3 sang Unicode (ngầm định) 

Ví dụ: 
=ConvertStr("Anh ch¼ng muèn") Kết quả "Anh chẳng muốn" 
=ConvertStr("Anh ch¼ng muèn", 6) Kết quả "Anh chẳng muốn" 

Các lệnh xử lý 
Tương tự như các hàm trong Add-in A-Tools cung cấp các lệnh và phân theo các khối việc 
như là: Chuyển mã; Cập nhật công thức; Định dạng; Xóa công thức để lại giá trị;... 
Quy trình thực hiện 
b1- Chọn vùng dữ liệu càn thực hiện 
b2 - Vào menu A-Tools->Lệnh rồi chọn lệnh mà bạn muốn 
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Thông tin chi tiết mới nhất về Add-in A-Tools các bạn có thể xem tại đây: 

http://www.bluesofts.net/Products/AddIns/A-Tools/Index.htm 

Xem video hướng dẫn Add-in A-Tools  

http://www.bluesofts.net/Products/AddIns/A-Tools/Help/DEMO/Index.htm 

Hướng dẫn kết nối dữ liệu Excel qua mạng: 

http://www.bluesofts.net/Products/AddIns/A-Tools/Help/DEMO/A-Tools_Network/A-
Tools_Network.html 

Xử lý lỗi khi A-Tools không khởi động cùng Microsoft Excel 

http://www.bluesofts.net/Baiviet/Office/ExcelEnabledAddin/Index.html 

http://www.bluesofts.net/Products/AddIns/A-Tools/Index.htm
http://www.bluesofts.net/Products/AddIns/A-Tools/Help/DEMO/Index.htm
http://www.bluesofts.net/Products/AddIns/A-Tools/Help/DEMO/A-Tools_Network/A-Tools_Network.html
http://www.bluesofts.net/Products/AddIns/A-Tools/Help/DEMO/A-Tools_Network/A-Tools_Network.html
http://www.bluesofts.net/Baiviet/Office/ExcelEnabledAddin/Index.html

